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General Setup/Customization 

Set Up Default Tax, Service Charge, and Gratuity 

 
1. Click the Administration ribbon tab. 
2. Click the General button and choose Tax/Service Charge 

Rates. 
3. Enter a new tax rate for your Food/Service items by typing the 

number into the Food field within the Tax 1 column. 
4. Repeat as desired to enter default tax rates for all other item types.  
5. Optionally continue to add rates into the Tax 2 and Tax 3 columns, if needed. (You can rename these fields. 

See the next topic, “Rename Existing Fields.”) 
6. Optionally click the Tax Schedules button to create multiple tax schedules, located on the upper right-hand 

side of the window, which can be assigned to individual customers (accounts) or site locations used for an 
event.  

7. Continue to add rates for default Gratuity and/or Service Charge for each type of item. 
8. [Optional] Click into the Tax Exempt checkbox to make all new events default to Tax-Exempt. 
9. [Optional] Enter whole dollar amounts into any of the fields under Additional Adjustments  

to add that amount to the Subtotal, Tax, Gratuity, or Service Charge of all new events.  
10. When finished, click OK.  
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Default_Tax_Rates.htm) 

 

 Multiple tax rates are often used by 

European or Canadian companies and can also 

be used in the U.S. to track separate City, State, 

and County taxes. 

http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Default_Tax_Rates.htm
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Rename Existing Fields 

 
1. Click the Administration ribbon tab.  
2. Click the General button and choose Customize Names.  
3. Click into any field and type a new name for the field as 

desired.  
4. When finished, click OK.  (A prompt will indicate that 

your prints will be affected due to the changes you 
made; you will need to redefine the fields in Print Designer. Click OK at the prompt.) 

 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Renaming_Fields.htm and 
http://support.caterease.com/20/helpmenu/Content/Setup/Renaming%20the%20Time%20Fields.htm) 

 

 Many fields in Caterease can be renamed using 

the steps described here. For example, you might 

prefer the name “Booking Agent” to Sales Rep, or 

“Scheduled Items” to Scheduled Vans or Scheduled 

Tables, for example. You can also use this area to 

rename event time and guest fields. 

http://support.caterease.com/20/helpmenu/Content/Setup/Renaming_Fields.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Renaming%20the%20Time%20Fields.htm
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Create User-Defined Fields 

 
1. Click the Setup sidebar.  
2. Click the User Defined Fields button.  
3. Click the appropriate tab for the type of field you are creating. For 

example, click the Events tab for your Event Manager, Accounts tab 
for your Account Manager, etc. 

4. Click into the first available user-defined field and type the new field 
name as desired. 

5. Click the down arrow to the right of the Type field and select a format type for this field. (Choose from 
among Text; Phone; Number; Currency; Date; and Time.)  
Note: Click the X, to the right of the field, to reset to N/A, with a Type of Text, and to also clear any required 
field settings. (See the section entitled “Establish Required Fields” for more information about using 
required fields.) 

6. When finished, click OK. 
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Creating_User_Defined_Fields.htm) 
 

 

 You can create user-defined fields to 

keep track of information (about your 

clients, events, menu items, etc.), that is 

unique to your company. These fields can 

be displayed anywhere in their respective 

areas of the program or on prints.   

http://support.caterease.com/20/helpmenu/Content/Setup/Creating_User_Defined_Fields.htm
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Add User-Defined Fields to Your Screen 

 
1. In Event Manager (or other “Manager”), click your right mouse button on the tab where you would like to 

place the user-defined field.  
2. Click Customize. 
3. Hold your left mouse button down on one of the available fields. 
4. Drag the field into the desired location on your screen, and then release your mouse button.   
5. Repeat as desired, and then click Close to close the Customize window. 

6. Click the Save Current Window Settings button  to retain the settings for yourself or for the other 
users in your Caterease network.  
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Creating_User_Defined_Fields.htm) 

 

 

 

 

 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Creating_User_Defined_Fields.htm
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Set up/Customize Quickpick Lists 

 
1. Click the Setup sidebar. 
2. Click the Quickpicks button. 
3. Click the Expand button to the left of any quickpick category to 

expand the selection.  
4. Click on the name of the sub-category you would like to add a 

quickpick item to. 

5. Click the Add New Item button , located at the top right-hand side of the window, to add a new 
quickpick. 

6. Type the name of the quickpick into the field. 
7. When finished adding quickpicks, click Close.  

 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Customizing_Quickpick_Lists.htm) 

  

 Various drop-down lists are available 

throughout Caterease, from which you can 

choose from a list of options, or “quickpicks.” 

Quickpicks allow you to keep your data entry 

consistent among users. Note: You can even 

add quickpicks to User-Defined fields.  

http://support.caterease.com/20/helpmenu/Content/Setup/Customizing_Quickpick_Lists.htm
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Establish New Booking Defaults 

 
1. Click the Administration ribbon tab. 
2. Click the General button and choose New Booking Defaults.  
3. Click the tab representing the area of the program where 

you want to create New Booking Defaults. 
4. Enter information into the fields provided by typing directly 

into the fields or by selecting options from the drop-down quickpick lists. 
5. Click into a checkbox to enable a default feature. 
6. When finished entering new booking defaults, click OK.  
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_New_Booking_Defaults.htm) 

 

  

 With New Booking Defaults, you can set 

certain default values for various fields in the 

program. These values can be overwritten at any 

time, but they exist to save time when entering new 

events/accounts/prospects, etc., into Caterease. 

http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_New_Booking_Defaults.htm
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Establish Required Fields 

 
1. Click the Administration ribbon tab. 
2. Click the General button and choose Required Fields. 
3. Click the tab representing the area of the program where 

you want to create required fields. For example, click the 
Events tab for your Event Manager, Accounts tab for your 
Account Manager, etc. 

4. In the right-hand pane of the window, click into the checkbox next to any field  
you want to designate as required information. 

5. Optionally create conditionally required fields (click the link below for more information). 
6. When finished, click OK. 

 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Making_Fields_Required.htm) 

 

 You can make certain fields “required” so 

that a record will not save without having the 

necessary fields filled in. You can even make 

certain fields conditionally required, meaning 

certain details are required for one type of event 

or customer but might not be required for others. 

http://support.caterease.com/20/helpmenu/Content/Setup/Making_Fields_Required.htm
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Establish Conditional Deposit Schedules 

 
1. Click the Administration ribbon tab. 

2. Click the Options button and choose Deposit Schedule. 

(Not available in Express.) 

3. Click the Add Group button , located at the top left-hand 

side of the Conditional Group pane. 

4. Select a condition from the Create a new group that applies 

to... drop-down list. Choose from the following: 

 

• All Events (Note: If All Events is selected, the second 

drop-down list will not display.) 

• Events with a Status of (or Category of; Theme of; Operation of; Business Type of; Sales 

Representative of) 

 

5. Click OK. 

6. Click the Add Scheduled Deposit button  , located on the right-hand side of the window. 

7. In the Deposit Details area, choose whether this deposit will be due Before or After the Event Date or the 

date on which the event is booked (Booked Date), and how many days/week/months before/after the 

Event Date/Booked Date. 

8. Determine whether the amount of the deposit should be calculated as a percentage of the event totals or 

as a whole-dollar amount by choosing either A Percent or An Amount from the drop-down list. 

 

• If setting a percentage of the event totals, use the fields in the fourth row of the Deposit Details area 

to set the percentage amount (first field) and the total to use as the basis. 

Note: You would probably use the "Remaining balance due" option for all subsequent deposits after the 

first one. For example, a possible first deposit might be "50% of the Total balance due," but subsequent 

deposits might be based on the balance that remains. In other words, "Total balance due" represents 

the total amount of sales for that event, regardless of whether any deposits have been received. 

 

9. If setting a whole-dollar amount, use the field in the fifth row of the Deposit Details area to set that dollar 

amount, either by typing into the field or by clicking the down arrow to access the drop-down calculator. 

 You can create automatic schedules of 

future deposits for your parties, complete with 

due amounts (in dollars or percentages of event 

totals) and due dates (relative to the event date or 

booked date), and then use these schedules for 

the various events that you book. Schedules can 

be conditional, so it applies only to a certain type 

of event. What's more, you can even tell the 

program to automatically update the due amounts 

or due dates if details of the party change.  
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Important Note: The program evaluates these conditions in the order they are listed, and it stops when it 

reaches a condition that is true. For example, if your first condition for events says "Category = Business" and 

your second condition says "Status = Definite," when the program finds an event with a category of "Business," 

it will apply those required fields and stop - never evaluating for the second condition. For this reason, it is 

imperative that any condition that says "All" records ("Events," "Accounts," etc.), must be the LAST condition 

listed. 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Creating_Default_Deposit_Schedules.htm) 

 

 

 

  

http://support.caterease.com/20/helpmenu/Content/Setup/Creating_Default_Deposit_Schedules.htm
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Set  up Automatic Change Notifications  

 
1. Click the Administration ribbon tab. 

2. Click the General button and choose Notifications Setup. 

(Not available in Express.) 

3. Click the Add Notification button .  

4. Fill out the information in the Notification Details area: 

 

• Name: Type a Notification Name into the Name field. 

• Change In: Choose from the list of options available in the drop-down list to the right of the 

Change In field: Events, Sub-Events, Food/Service Items, Shifts, Payments. 

• Type: Select Change or New from the Type drop-down list. 

 Note: "New" is available only if Event or Payment is selected in the Change In field. 

• Change Of: Select an option from the Change Of drop-down list. 

Note: Available options depend on what is selected in the Change In field. 

• Category: Select an option from the drop-down quickpick list to the right of the Category field. 

5. Optionally apply any desired filters by clicking the Filter button  and customizing the conditions. (See 

the next section.) 

6. Click the Select User button , in the Notify Users area at the bottom right-hand side of the window. 

7. Double-click any User Name/Sales Rep who should receive this notification. 

8. Click the , located at the upper right-hand side of the window, to close the window. 

9. Click into the Text Msg and/or Email checkbox next to a User Name/Sales Rep to choose which users will 

be alerted via e-mail or text message when changes have been made or records have been added. (See the 

link below for setup instructions.) 

10. Click OK to save your changes and exit.  

(See the image on the following page.) 

 It is extremely important for you and your 

team to be constantly updated. The incredible 

Caterease Automatic Notifications feature not only 

lets you tell the program what specific changes you 

or others want to be notified about, but it also 

allows you to have those notifications sent to you 

via e-mail or text. 
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(See http://support.caterease.com/20/helpmenu/Content/General_Information/User%20Notifications%20Module.htm) 

  

http://support.caterease.com/20/helpmenu/Content/General_Information/User%20Notifications%20Module.htm
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Set Up the Scratch Pad 

 
1. Click the Administration ribbon tab. 
2. Click the Lists button and choose Scratch Pad. 

3. Click the Add New Category button , located on the left-
hand side of the window.   

4. Click Yes at the confirmation prompt.  
5. Type a name for the new category and press [Enter].  
6. Click into the large white text block on the right-hand side of 

the window and type notes for this category. Browse to a stored image or add current date and time  
by right-clicking and choosing Insert > Image or Insert > Current Date & Time, respectively. 

7. Click the  at the upper right-hand side of the window.  
Note: You will be prompted to save your changes. 

 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Setting_Up_the_Scratch_Pad.htm) 

 

  

 You can avoid repetitive typing by 

storing large amounts of commonly used 

text, such as Comments, Notes, special 

requests, etc., into the Scratch Pad. 

http://support.caterease.com/20/helpmenu/Content/Setup/Setting_Up_the_Scratch_Pad.htm
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Add Users 

 
1. Click the Administration ribbon tab and choose Security.  
2. Click the Users tab. 

3. Click the Add User button , located on the right-hand side of the window. 
4. Enter a User Name for the new user. 
5. Click the ellipsis button to the right of the Password field to assign a password. 
6. Click Yes at the confirmation prompt. 
7. Enter a password for the user. 

Note: You will be prompted to re-enter the password. 
8. Optionally click into the Active Directory Name field and enter the user name for logging into Windows or 

Caterease Connect. 
9. Fill out Contact information (phone, e-mail) as desired. 
10. Click OK. 
11. Click the Security tab on the left-hand side of the window and establish security settings.  
12. When finished, click OK.  
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Security/Adding_a_New_User.htm) 
 

http://support.caterease.com/20/helpmenu/Content/Setup/Security/Adding_a_New_User.htm
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Add Sales Reps 

 
1. Click the Administration ribbon tab and choose Security.  
2. Click the Users tab. 

3. Click the Add User button , located on the right-hand side of the window. 
4. Enter a User Name for the new user. 
5. Click the ellipsis button to the right of the Password field to assign a password. 
6. Click Yes at the confirmation prompt. 
7. Enter a password for the user. 

Note: You will be prompted to re-enter the password. 
8. Click OK. 
9. Enter contact information into the fields provided (Telephone/Cellular/Email). 
10. Click into the checkbox labeled Is A Sales Rep. 
11. Optionally add any notes by clicking the Notes tab and typing into the text block. 
12. Optionally add a picture by clicking the Picture tab and choosing an image. 
13. When finished, click OK.  

 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Security/Adding_a_New_User.htm) 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Security/Adding_a_New_User.htm
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Configure E-mail Settings  

 
1. Click the Administration ribbon tab. 
2. Click Settings > Email Settings. 

3. Click the New Record button , located at the top left-
hand side of the window. 

4. Click on the new name in the user list and click the down arrow to the  
right of the field to select a desired user name. 

5. Establish the appropriate e-mail settings in the right-hand pane of the window.  
6. Optionally click the Settings tab, at the bottom of the window, and enter a signature,  

default CC List, and default BCC List to be associated with this user.  
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Email_Settings.htm) 
 

  

 Each Caterease user can have his/her own 

unique e-mail settings, determining which e-mail 

account Caterease e-mails are sent through, as 

well as other options, such as a default signature. 

http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Email_Settings.htm
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Add Default Site Locations 

 
1. Click the Setup sidebar.  
2. Click the Site Locations button.   

3. Click the Add Record button , located in the Home 
ribbon tab at the top  
of the screen.  

4. Click Yes at the confirmation prompt.  

5. Type a name for your new site location and press [Enter]. 
6. Enter additional information into each field. 
7. Optionally add a Picture, Description, and Notes.  
8. Optionally click the Directions tab at the bottom of the window and enter directions to the location, or 

use the Get Map tool . 
9. Optionally click the Required Items tab at the bottom of the window and associate required items 

(packing list) with the site location.  For more information, see “Create a Required Items List.” 

10. Optionally associate Site Commission Rates  to a particular site. Note: You can run the Site 
Commission Rates report (Reports > Financials > Site Location Commissions), totaling the commissions 
due to each site location for a particular day or date range.  
 

 
 
(See http://support.caterease.com/20/helpmenu/Content/Setup/Entering_Site_Locations_into_the_Site_Locations_Database.htm) 

 

 

 

 Use this tool to establish a default site 

location for a client. Any details you enter here 

will default as the site location details for any new 

event created for this client. 

http://support.caterease.com/20/helpmenu/Content/Setup/Entering_Site_Locations_into_the_Site_Locations_Database.htm
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Set Up Default Timelines 

 
1. Click the Administration ribbon tab.  
2. Click the Lists button and choose Default Timeline Items. 

3. Click the Add New Timeline button , located on the 
left-hand side of the window. 

4. Click Yes at the confirmation prompt. 
5. Type over the name “New List” to rename your new default timeline, and press [Enter]. 

6. Click the Add New Timeline Item button , located on the right-hand side of the window, to add a new 
timeline item. 

7. Type a timeline item into the Item field, and press [Tab] to move to the next field. 
8. Select a Category from the drop-down quickpick list. 
9. Optionally type the time for the item to occur, into the Time field. 

Note: You may also click the up-and-down arrows to select the time. 
10. Optionally add any timeline notes by typing into the Notes text block. 
11. Click OK.  

 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Event_Manager/Creating_a_Detailed_Event_Timeline.htm) 
 

 

 

 In addition to various time fields available 

in Event Manager, you can create a detailed 

timeline unique to each party. You can create 

these times on-the-fly from within an event (or 

select them from default lists). 

http://support.caterease.com/20/helpmenu/Content/Event_Manager/Creating_a_Detailed_Event_Timeline.htm
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Set Up Default Checklists  

 
1. Click the Administration ribbon tab. 
2. Click the Lists button and choose Default Checklists. 

3. Click the Add New Checklist button , located on the 
left-hand side of the window.  

4. Click Yes at the confirmation prompt. 
5. Type over the name “New Checklist” to rename your new default checklist, and press [Enter]. 

6. Click the Add New Checklist Item button , located on the right-hand side of the window, to add a new 
checklist item. 

7. Type a checklist item into the Item field, and press [Tab] to move to the next field. 
8. Select a Category from the drop-down quickpick list. 
9. Click the down arrow to the right of the Assigned To field to select the person responsible for the checklist 

item. 
Note: You may also type the name directly into the field.  

10. Optionally add any checklist notes by typing into the Notes text block, located on the Notes tab.  
11. Click OK. 

 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Event_Manager/Creating_a_Checklist_of_To-Do_Items.htm) 

 You can create a checklist of "to-do" items for 

your various events, either selecting from default 

lists of tasks or adding a custom task on-the-fly.  

http://support.caterease.com/20/helpmenu/Content/Event_Manager/Creating_a_Checklist_of_To-Do_Items.htm
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Customize Your Tools Menu and Toolbar 

 
1. Click the Tools button, located the Home ribbon tab of any 

Manager (Event Manager, Account Manager, etc.). 
2. Click Customize, located at the bottom of the Tools drop-

down menu. 
3. To remove a shortcut, click on a shortcut from the Tools 

Menu Shortcuts pane (left-hand side), hold, then drag to the trashcan icon at the bottom of the window. 
4. To add a shortcut, click on a shortcut from the Available Shortcuts pane (right-hand side), and drag and 

drop into the Tools Menu Shortcuts pane. 
5. To reposition buttons, drag and drop them up and down as desired in the list of Tools Menu Shortcuts. 
6. When finished, click OK. 

7. Click the Save Current Window Settings button  to save your customizations for yourself or for other 
users within your Caterease network. 
 

 
  
(http://support.caterease.com/20/helpmenu/Content/General_Information/Customizing%20the%20Tools%20Menu%20and%20Tool%2

0Bar.htm) 

 

 

  

 Every Manager has a unique and dynamic 

Tools Menu and Tools Bar.  Any frequently used 

tools can be made instantly accessible through the 

Tools Bar, while tools that you use “every so often” 

can be available in the Tools Menu drop-down list. 

http://support.caterease.com/20/helpmenu/Content/General_Information/Customizing%20the%20Tools%20Menu%20and%20Tool%20Bar.htm
http://support.caterease.com/20/helpmenu/Content/General_Information/Customizing%20the%20Tools%20Menu%20and%20Tool%20Bar.htm
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Menu Setup/Customization 

Customize Food/Service Item Types 

 
1. Click the Administration ribbon tab. 
2. Click the General button and choose Food/Service Item Types. 
3. Click into the Type field and type the new food/service item type over “N/A.” 
4. Click the down arrow to the right of the Image field and select an image from  

the drop-down list. 
5. Click into the checkbox under the Active field to activate the new food/service item type. 
6. Click into the Associate Charges area to associate a Room, Labor, Delivery, or Miscellaneous  

charge to the Item Type. 
Note: You will need to assign tax/service charge rates for the new item type. 

7. Drag and drop the item types into the desired position.  
8. When finished, click OK.  

 

 

(http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Setting%20Up%20Food%20Service%20Item%20Type

s.htm) 
  

  

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Setting%20Up%20Food%20Service%20Item%20Types.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Setting%20Up%20Food%20Service%20Item%20Types.htm
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Create Your Menus 

 
1. Click the Setup sidebar. 
2. Click the Menu Manager button. 

3. Click the Add New Menu button , located on the upper left-hand side of your screen. 

4. Click Yes at the confirmation prompt.  
5. Type a name of the new menu and press [Enter]. 

6. Add a new menu item by clicking the Add Menu Item button , located at the top of the Menu 
Manager window. 

7. Type the name of the food/service item into the blank Item Name field, and then press [Tab]. 
8. Fill out the Price, Prep Area, Category, Comment, etc., information as desired. 

Note: Click the Quick Column Customizing button , located at the left of the Item Name field,  
to access optional fields. 

9. When finished, click the  at the top right-hand side of the window. 
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Adding_a_New_Menu.htm) 

 

  

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Adding_a_New_Menu.htm
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Create an Ingredients List 

 
1. Click the Setup sidebar. 
2. Click the Ingredient Manager button. 

3. Click the Add Menu button , located on the upper left-
hand side of the screen. 

4. Click Yes at the confirmation prompt.  
5. Type a name for your new ingredients list, and press [Enter]. 

6. Add a new ingredient by clicking the Add Ingredient button , located at the top of the Ingredients List 
window.  

7. Type the ingredient name into the Item Name field, and press [Tab] to move to the next field.  
8. Enter the Category, Prep Area, Type, and Comment into their respective fields. 

Note: Click the Quick Column Customizing button , located at the left of the Item Name field,  
to access optional fields. 

9. When finished, click the  at the top right-hand side of the window. 
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Ingredients%20Lists.htm) 

 

 

  

 To select ingredients for each of your 

menu items in your default menus, you must 

first create a master list of ingredients from 

which to choose.   

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Ingredients%20Lists.htm
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Assign Ingredients 

 

1. Click the Setup sidebar. 
2. Click the Menu Manager button. 
3. In the left-hand pane of Menu Manager, click on the title of the menu you would like  

to add an ingredient to. 
4. Click the Recipe tab, located towards the bottom of the screen.  

5. Click the Select Items button , located on the right-hand side of the window. 
6. Highlight and select desired ingredients. 
7. Click into the Qty column and enter a quantity for each ingredient item. 

Note: Click the Quick Column Customizing button , located to the left of the Item Name field, 

to access optional fields. 
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Ingredients%20Lists.htm) 

 

Note: Refer to the Ingredient Supplement at the end of this guide for additional details.  

 

 

 

 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Ingredients%20Lists.htm
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Create a Required Items List  

 
1. Click the Setup sidebar. 
2. Click the Required Items button. 
3. the left-hand pane of the window. 
4. Click Yes at the confirmation prompt. 

5. When finished, click the  at the top right-hand side of the window.  
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Required%20Items%20Lists.htm) 

 

 

 

 

 

 

 

 

 

 If a menu item requires certain accessories 

(chafing dishes, utensils, napkins, plates, etc.), 

each time it is serviced, you can attach a custom 

list of those “required items” to that menu item.     

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Required%20Items%20Lists.htm
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Assign Required Items 

 

1. Click the Setup sidebar. 
2. Click the Menu Manager button.  
3. In the left-hand pane of Menu Manager, click the title of 

the menu you would like to assign a required item to. 
4. Click the Required Items tab, located towards the bottom 

of the screen. 

5. Click the Select Items button  at the right-hand side of the Required Items window. 

6. Highlight and select the required items. 
7. Enter a Default Qty for your required items. 

8. Click the Quick Column Customizing button  to access additional columns, such as Link, where you can 
optionally link the quantity of this item to the number of corresponding menu items ordered in an event. 
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Required%20Items%20Lists.htm) 

 

 

 

 

 

 

 Whenever you retrieve a menu item (that has 

“required items” associated with it) into an event, 

the corresponding list of required items will be 

retrieved and automatically totaled up based on 

the quantity of menu items you order. 

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Building%20Required%20Items%20Lists.htm
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Add Vendors 

 
1. Click the Setup sidebar. 

2. Click the Vendor List button. 

3. Click the Add Record button , located in the Home ribbon tab at the top 

4. Enter additional information into each field. 

5. Optionally add a Description, Notes, Directions, or Picture.  
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm 

and  

http://support.caterease.com/20/helpmenu/Content/Event_Manager/Printing_Menu_Item_Vendor_Lists.htm) 

 

 

 

 

 

 

 

 Each menu item (or ingredient item) 

can have a specific vendor associated with it. 

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm
http://support.caterease.com/20/helpmenu/Content/Event_Manager/Printing_Menu_Item_Vendor_Lists.htm
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Assign Vendors 

 

1. Click the Setup sidebar. 

2. Click the Menu Manager button. 

3. In the left-hand pane of Menu Manager, click on the title of the menu or sub-menu to which you would 

like to add a vendor.  

Note: You can also assign vendors to ingredients, in Ingredient Manager.  

4. In the main pane of Menu Manager, select the food/service item to assign. 

5. Click the Quick Column Customizing button , located to the left of the Item Name column. 

6. Click into the Vendor checkbox to add the Vendor column to your screen display. 

7. Click the down arrow to the right of the Vendor field and select an option from your default list. 

8. Click the Save Current Window Settings button to save this as a default setting for yourself or for the 

other users on your Caterease network every time you open Caterease. 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm)  

http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Menu_Manager/Creating%20Default%20Vendor%20Lists.htm
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Room/Venue Customization 

Add a Master List of Setup Styles 

 
1. Click the Administration ribbon tab. 
2. Click the Venues button and choose Setup Styles.  

3. Click the Add New Setup Style button , located at the top of the window. 
4. Type a name for the new setup style. 
5. Optionally add notes by typing into the Notes text block. 
6. Optionally add a picture by right-clicking into the Picture text block and 

 choosing Load From File.  
 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm) 

 

 

 

 

 

 

 If you own the Banquet Rooms module in Caterease, 

your program will warn you if you have any conflicts with 

your banquet space, including double-booking, guest 

capacity conflicts, and unrecognized setup styles. 

http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm
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Create Locations to Group Your Rooms (Optional) 

 
1. Click the Administration ribbon tab. 
2. Click the Venues button and choose Banquet Rooms Setup. 

3. Click the Add Location button , located at the top left-hand side of the window. 
4. Click Yes at the confirmation prompt. 
5. Type a name for your new location. 
6. Optionally click on the ellipsis button and add notes by typing into the Notes text block. 
7. Optionally add a picture by right-clicking into the Picture block and choosing Load From File.  

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm) 

Add Banquet Rooms to Your Locations 

 
1. Click the Administration ribbon tab. 
2. Click the Venues button and choose Banquet Rooms Setup. 
3. In the left-hand pane of the window, select the location you want to add a new room to.  

4. Click the Add Room button , located at the top left-hand side of the window. 
5. Type a name for your new location. 

 

 
 

 (See http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm) 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm
http://support.caterease.com/16/helpmenu/Caterease%20Help.htm#Setup/Setting%20up%20Banquet%20Rooms.htm
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Establish Setup Styles and Capacities for a Room 

 
1. Click the Administration ribbon tab. 
2. Click the Venues button and choose Banquet Rooms Setup. 
3. In the left-hand pane of the window click on the name of the room you would like to  

assign a setup style to. 

4. Click the Select Setup Style button , located on the upper right-hand side of the window.  
5. Double-click on the name of the setup style to select. 
6. Type the room capacity into the Capacity field.   

 

 
 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm) 

 

  

http://support.caterease.com/20/helpmenu/Content/Setup/Setting%20up%20Banquet%20Rooms.htm
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Restrict Events    

  
1. Click the Administration ribbon tab at the top of your screen. 

2. Click the Options button and choose Restrict Events. (Not 

available in Express.) 

3. Click into the checkbox labeled Limit Daily # Of Events, 

located on the Limit Daily # tab. 

4. Select an option under Limit By ... . 

Result: With any choice other than All Events, the 

corresponding quickpick list is displayed on the right-hand side of the window. 

Note: If you select All Events, simply enter a daily maximum number by clicking into the field and typing or 

by using the up-and-down arrows to adjust the number. 

Important Note: A zero value in the Max # field means there is no limit to the number of daily events. 

5. Click into each row on the right-hand side of the window and enter a maximum number (Max #) for each 

selection. 

Note: Skip this step if you chose All Events in Step 4, above. 

6. When finished, click OK. 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Daily_Event_Limits.htm) 

 

  Perhaps your company has a policy that it 

only does one off-premise party per day. Or 

perhaps you limit the number of events you hold 

each day with a certain theme. Or maybe you just 

have a fixed limit (meaning you can only do “x” 

number of events per day). In any case, you can set 

these limits easily and let Caterease keep track of it 

all for you. 

http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Daily_Event_Limits.htm
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Establish “Closed Dates” for Your Company 

 
1. Click the Administration ribbon tab at the top of your screen. 

2. Click the Options button and choose Restrict Events.  (Professional version only.) 

3. Click the Closed Dates tab. 

4. Click the Add Record button , located on the upper right-hand side of the window. 

5. Click the radio button to the left of Day of Week if you would like to indicate non-availability for a certain 

day of the week, then choose the desired day from the drop-down list at the right-hand side of the 

window. 

Result: The Range option becomes available. Click into the Range checkbox. Access the drop-down 

calendar tool to the right of the Start and Finish fields to set a closed-for-business date range. 

Note: If you did not choose Day of Week, click the radio button to the left of Specific Date and access the 

drop-down calendar to the right of the field to select one specific closed-for-business date. 

6. [Optional] Type a reason for the closure into the Reason field. 

7. [Optional] Type a comment for the closure into the Comment text box. 

8. When finished, click OK. 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Daily_Event_Limits.htm) 

 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Establishing_Daily_Event_Limits.htm
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Staff/Position Setup/Customization 

Add Employees 

 
1. Click the Main sidebar. 
2. Click the Employee Manager button. 

3. Click the Add Record button , located in the Home ribbon tab at the top of the screen. 

4. Click Yes at the confirmation prompt. 

5. Type the employee’s last name into the Last field, and press [Tab] or [Enter]. 

6. Fill out the remaining General tab fields by typing directly into the fields or  
selecting the desired quickpick item from the drop-down lists. 

7. Click the Address tab and complete the Home Address and Mailing Address fields. 

8. When finished, click the Save Changes button , located in the Home ribbon tab.  
 

 
 

(http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Creating%20a%20Default%20List%20of%20Empl

oyees.htm) 

 

  

http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Creating%20a%20Default%20List%20of%20Employees.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Creating%20a%20Default%20List%20of%20Employees.htm
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Add Positions 

 
1. Click the Main sidebar. 
2. Click the Employee Manager button. 
3. Click the Tools button and select Shift Setup. 

4. Click the Add Position button , located at the top left-hand side of the window. 
5. Click Yes at the confirmation prompt.  
6. Type the name of the position into the Position field. 
7. Optionally complete the Uniform and Agency fields. 
8. Optionally enter an Estimated Cost (Wage) into the Est Cost field. 
9. Click into the Price field and type a default price (per hour) for the shift. 
10. Optionally click into the Flat Rate checkbox to designate the shift as a flat rate. 

Note: Flat rate is used as an alternative to hourly rate. 
11. Optionally select the Default Shift Times by clicking the down arrow to the right of each field and selecting 

from the available options.  
12. Optionally enter any desired notes into the Notes text block. 
13. Click the Close button.  

 

 
  

(See http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Creating_Default_Shifts_or_Positions.htm) 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Creating_Default_Shifts_or_Positions.htm
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Assign Positions 

 

1. Click the Main sidebar. 
2. Click the Employee Manager button. 
3. Click the Positions tab, located at the bottom of the Employee Manager screen. 

4. Click the Select Positions for Employee button , located on the right-hand side of the screen. 
5. Highlight one or more positions and then click the Select button. 

6. Click the , located on the upper right-hand side of the Select Position window, to close the window. 
7. Populate any additional information, such as Uniform and Wage information, as desired.  

8. When finished, click the Save Changes button , located in the Home ribbon tab. 
 

 
 
(http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Assigning%20a%20Position%20to%20an%20Em
ployee.htm) 

 

 

 

 

 

 

http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Assigning%20a%20Position%20to%20an%20Employee.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Employee_Manager/Assigning%20a%20Position%20to%20an%20Employee.htm
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Global Settings Customization 
 
1. Click the Administration ribbon tab at the top of the screen. 
2. Click Settings and choose Global Settings.  
3. Click a specific tab on the left-hand side of the window to edit 

settings related to that area of the program. 
4. When finished, click OK.  
 

 

(See http://support.caterease.com/20/helpmenu/Content/Setup/Editing_Global_Settings.htm) 

 
 
 
 
 
 
 
 
 
 
 
 

 The Global Settings feature allows you to 

change certain settings in the program and affect 

all users on your Caterease network. Settings 

here include general regional and field settings, 

as well as a variety of other miscellaneous 

settings. 

http://support.caterease.com/20/helpmenu/Content/Setup/Editing_Global_Settings.htm
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Resources for Additional Setup Tasks 
 

• Context-Sensitive Help (In any area of your program, press the [F1] key on your keyboard. You will see 

context-sensitive help that is specifically applicable to wherever you are in the program, complete with 

links to full-length topics.)  

• Online Help Menu (Help ribbon tab > Caterease Help > Index or Search) 

• Tip of the Week Videos https://www.caterease.com/category/tip-of-the-week/ 

• Documentation  https://www.caterease.com/support/documentation/ 

 

Caterease Connect Mobile App 
• Using the Caterease Connect Mobile App  (Online Help topic, including Setup.  Note: The login to your 

mobile app is different from your regular Caterease login.) 

• https://fast.wistia.net/embed/iframe/usdy8vx4o5?popover=true  (Setup Video) 

 

Security 
• Enabling System Security (Online Help Topic) 

• Adding a New User (Online Help Topic) 

• https://www.caterease.com/setting-security-group-users-one-time/ (Tip of the Week Video) 

 

  

https://www.caterease.com/category/tip-of-the-week/
https://www.caterease.com/support/documentation/
http://support.caterease.com/20/helpmenu/Content/General_Information/Using%20the%20Caterease%20Connect%20Mobile%20App.htm
https://fast.wistia.net/embed/iframe/usdy8vx4o5?popover=true
http://support.caterease.com/20/helpmenu/Content/Setup/Security/Enabling_System_Security.htm
http://support.caterease.com/20/helpmenu/Content/Setup/Security/Adding_a_New_User.htm
https://www.caterease.com/setting-security-group-users-one-time/
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Supplement: Exploring Ingredient Manager 

Using the Unit Builder Utility 

 
The Unit builder utility allows users to build units of measure for ingredients and establish their respective 

conversion rates. Some “units of measure” might be unique to specific ingredient items, even if they appear to 

be generic. For example, a “box” is quite different when it measures salt than when it measures cereal.  

When working with the Unit Builder, there are three basic criteria to consider: 

1. Is this a BASE unit, meaning is this unit the smallest unit a particular ingredient can be measured in 

(e.g., “slice” of bread)? If the answer is Yes, then this unit should be added to Unit Builder, but only to 

be converted from, not converted to. Then the user can choose only specific ingredient items to 

convert from this unit (in this example, bread).  

2. Is this a larger unit that applies as defined to all ingredients? If the answer is No, then it should be 

added as an item-specific unit to a specific ingredient item (like a “box” added specifically to the 

ingredient salt and another box added specifically to the ingredient flour).  

3. Will this unit be returned after the event, or will it be consumed/used along with the menu item? If it 

will be returned, then it should be a required item or packing unit; it should not be an ingredient unit.  

Accessing the Unit Builder 

 

To access the Unit Builder, click the Administration ribbon tab > Lists > Unit Builder. 
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Three standard measurement Unit Types are available: Volume, Weight, and Quantity. Each unit type has 
several base units and one lowest base unit. 
(Note: These units cannot be deleted from Caterease, as each unit converts into another unit; 
however, you can add to these units. An ingredient must be a member of a Unit Type. If you add 
an Ingredient-Specific Unit, as defined in your Ingredient Manager, they will be available for this 
ingredient in addition to your core units.) 

Important Note: To disable specific conversions, such as Kilogram, you just need to uncheck the conversions. 

 

 

 

Creating Custom Units of Measure for Ingredients with Unit Builder  

1. To add Unit Types to each family type, click the Add Record button , 
located on the right-hand side of the Unit Builder window. 
Result: A line is added to the bottom of the list. 
2. Define the new unit and its relationship to any other unit by typing over 

the words New Volume Unit, New Weight Unit, or New Quantity Unit, as 

applicable.  

• Convert From: When checked, the unit will be available in any unit selection drop-down. 

• Convert To: When checked, this unit will be used in conversions from other smaller units. 
 
3. Enter a quantity into the Qty field. 
4. When finished, click OK. 

 
Volume Weight Quantity 

Gallon Kilogram Dozen 

Liter Pound Pair 

Quart Ounce *Item (Lowest Base Unit) 

Pint *Gram (Lowest Base Unit  

Cup   

Fluid Ounce   

Tablespoon   

Milliliter (Lowest Base Unit)   

 
 
 
 

 The lowest base unit is indicated by 

red font. The lowest base unit does not 

convert to any other unit. Unless you are 

an Administrator, Unit Type cannot be 

changed if an ingredient is already in use 

in a sub-recipe or a menu recipe. 
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Using the Item Details View – Units Tab  

 
The Item Details area (bottom pane) allows you to manage ingredient-

specific units, unit pricing, and unit conversions. 

The Item Details view allows you to manage ingredient-specific units, unit 
pricing, and unit conversions. 

• Item Name - Refers to the name of the ingredient item. 

• Revised - Provides a date- and time-stamp of when an item was revised (modified). 

• Revised By - Indicates the user name of the person who revised the ingredient item. 

• Unit Type - Three standard Unit Types are available: Volume, Weight, and Quantity. 

• Procurement Unit - The ingredient price is based on the Procurement Unit. This means 

• that the cost of all other units are derived from the Procurement Unit cost. 
Note: A sub-ingredient has a Recipe Yield Unit rather than a Procurement Unit. 

• Default Unit - This is the unit the ingredient defaults to when it is selected into Menu Manager. 

• Item Specific Units - This is a user-defined unit that has a set relationship with a standard unit 
(Volume, Weight, Quantity). If an item (such as salt, for example), is a member of the Volume unit type 
and you want to use a unit of measure that is in the Weight unit type, you can define that in the 
ingredients-specific unit type area. 

• Item Scales with Recipe - This feature is enabled by default. If an item is "scalable," the 
actual amount of the ingredient is derived from the servings of a particular recipe. 

 

 
 
 
 
 
 
 
 

 If the Item Scales with Recipe 

checkbox is checked, the ingredient will 

scale with the number of menu items 

ordered that contain the selected 

ingredient.  
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Creating Item-Specific Units 

 

Some units of measure might be unique to specific ingredient items. For example, a "box" is quite different 

when it measures salt than when it measures cereal or flour. This is where item-specific units come in. You can 

define specific units that only apply to individual ingredient items. 

1. Click the Setup sidebar, located on the left-hand side of your screen, and choose Ingredient Manager. 

2. Click on an ingredient from your list of ingredient items. (In the example below, rice is the ingredient.) 

3. Ensure the Units tab (the default) is selected. 

4. Click the Add Unit button , located in the Item Specific Units area on the lower right-hand side of your 

screen. 

Result: A new field displays. 

5. Type the new item-specific unit into the Unit Name field. In the example below, the unit name will be Box. 

6. Click the down arrow to the right of the Converts To field and choose an option from the list. In our 

example, we will choose Ounce. 

7. Type the quantity into the Qty. field. For our example, we typed 42, indicating the number of ounces. 

8. Ensure the Convert From and Convert To checkboxes have checks in them. 

9. Select the new custom unit, Box, from the Procurement Unit (Proc. Unit) drop-down list. 

10. Repeat this process with other items that use the box unit, as desired.  

Note: The quantity will change depending on the quantity of the new item. For example, the Qty for a box 

of raisins might be 30 ounces.  
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Using Sub-Recipes and Nested Sub-Recipes  

 
An ingredient can be a stand-alone item or it can be an item that is part of a 
sub-recipe. 
 
Click the Sub-Recipe tab to view ingredients and their respective units and 
quantities that make up the highlighted item. In the example below, Cocktail 
Sauce is the main ingredient. Spicy Ketchup (which is also highlighted) is 
listed as a sub-ingredient of Cocktail Sauce. 

 

Important Note: When establishing a sub-recipe, all ingredients that comprise your sub-recipe 
must exist in your Ingredient Manager.  

 

 

 Click on a Sub-Recipe to view any 

nested sub-recipes that have been 

added. In the example provided, Spicy 

Ketchup, which is a sub-recipe of 

Cocktail sauce, has a nested sub-recipe 

of Sage Dressing (also highlighted, in 

order to group the relationship with the 

sub-recipe and recipe).  


